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Information in this document is subject to change without notice and does not represent a commitment on 
the part of Software Bisque. The software and/or databases described in this document are furnished under 
a license agreement or nondisclosure agreement. They may be used or copied only in accordance with the 
terms of the agreement. It is against the law to copy the software on any medium except as specifically 
allowed in the license or nondisclosure agreement. The purchaser may make one copy of the software for 
backup purposes. 
 
No part of this manual and/or databases may be reproduced or transmitted in any form or by any means, 
electronic or mechanical, including (but not limited to) photocopying, recording, or information storage and 
retrieval systems, for any purpose other than the purchaser's personal use, without the express written 
permission of Software Bisque. 
 
This document was produced using Microsoft Word. 
 
© 1998-99 Software Bisque. All rights reserved. 
 
CCDSoft CCD Astronomy Software™  and TheSky Astronomy Software™  are trademarks of Software 
Bisque. 
 
Windows™  is a trademark of Microsoft Corporation. Microsoft Word™  is a registered trademark of 
Microsoft Corporation. 
 
All other product names are trademarks of their respective owners and are used solely for identification. 
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Typographic Conventions 
This manual uses the following typographic conventions. 

Example of Convention Description 
a:install 
; 12 15 36  74 15 19  

Courier type face is used for file and folder (directory) 
names, for text typed from the keyboard, and to display the 
contents of files and sample data. 

geometric 
CCDSoft  

Italic text is used to highlight new terms, for emphasis and to 
identify product names. 

F1 
ENTER 

Keystrokes are shown in caps. If two keys have a plus sign 
(+), press and hold the first key, then press the second. 

Windows Conventions 
This manual assumes you already have a basic understanding of how to use Windows. Here are a few 
reminders of mouse usage and Windows terminology. 
 

Term Description 
Click Point the mouse pointer (the on-screen arrow) to an object or 

command, then quickly press and release the left mouse button. 
“Click” always means click left. If you are supposed to press the 
right mouse button, it will say “Click right”. 

Double-click Point the mouse pointer (the on-screen arrow) to an object or 
command, then press the left mouse button twice, very quickly. 

Select Point the mouse cursor at a command or item in a list, then click 
the left mouse button. 

Drag Press and hold the left mouse button. Then move the mouse while 
continuing to hold the button down. 

Dimmed When a command or function is not available, it is shown in gray 
(rather than black). Unavailable functions are therefore said to be 
dimmed. 

Marked; Clear If a check box has a mark in it, it’s “marked”, if there is no mark, 
it’s “clear”.  

Control button The control button is the button on the upper left of a window or 
dialog box. Clicking it once displays the control menu. 

 



6 Orchestrate 
 

 

What is Orchestrate? 
Orchestrate is a Windows application that works in conjunction with TheSky™  Astronomy Software and 
CCDSoft™  CCD Astronomy Software to allow unattended, scripted operation of robotic telescopes, CCD 
cameras and other astronomical devices.  The entire nature of your observing system changes when these 
applications are combined using Orchestrate. 
 
Orchestrate goes beyond unattended control of telescopes and CCD cameras.  Your interactive sessions 
also benefit due to the flexibility and ease with which you can repeat operations or create custom observing 
scripts.  
 
Additionally, operations that are taxing to humans, or simply difficult to accomplish rapidly, can be 
relegated to the computer.  For example, slewing the telescope to a satellite, then quickly taking an 
exposure before the satellite has moved is difficult to accomplish interactively. Orchestrate makes it easy.  
 
Super novae and minor planet searches are two examples of space surveillance that are greatly aided by 
automation.  Using TheSky’s built-in Orchestrate script generator, mosaic grids can be generated so that 
Orchestrate will systematically image a given area of the sky with a specified overlap.  Your telescope and 
CCD camera can generate your own sky survey, while you sleep! 
 
This document is intended to provide sufficient information to get you started automating your 
astronomical hardware using TheSky, CCDSoft, and Orchestrate.  
 
The section titled “Exporting Data” describes how to create lists of objects or positions for use by 
Orchestrate using TheSky version 5.0.  

Compatible Devices 
TheSky Astronomy Software is used to control many different robotic telescopes including the following 
(all suited for automation). 
 
? ? Paramount GT-1100 from Software Bisque 
? ? Celestron Ultima 2000 series 
? ? Quadrant Systems Coordinate I series 
? ? Meade LX-200 telescopes 
? ? Telescopes supporting ACL (Astronomical Command Language) 
 
CCDSoft CCD Astronomy Software supports the following CCD cameras. 
 
? ? Santa Barbara Instrument Group (SBIG) ST-4, ST-4X, ST-5, ST-6, ST-7, ST-8  
? ? Celestron PixCel237 
? ? All CCD Cameras from Apogee Instruments 
 
The SBIG line of color filter wheels is also supported.  
 
Orchestrate uses a device independent, distributed (client/server) approach to automation. If you have 
hardware not listed, Software Bisque must develop a low-level driver for the device.  Once the driver is 
created, Orchestrate can control the device.   

Minimum System Requirements 
Orchestrate runs under Windows 95/98 or Windows NT 4.0.  At least 2 megabytes of free disk space is 
required for installation.  A minimum of 16 megabytes of RAM is recommended.  Orchestrate and its 
companion programs are computation-intensive applications that perform many floating-point operations. 
A math coprocessor (included on all Pentium processors) is required. 
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Installing Orchestrate 
Orchestrate is designed to run under Windows 95/98 or Windows NT, and take advantage of many of their 
features. Orchestrate is licensed as a single-user product— please do not install Orchestrate on a network. If 
you need a site-license, contact Software Bisque. 

Before starting installation…  
Read the readme.txt file on the installation disk #1. It might have last-minute information we were not able 
to put in the manual. 

Windows 95/98,NT 4.0 Installation 
1. Insert Disk #1 in the floppy drive. 
2. Select Start/Settings/Control Panel 
3. Double-click Add/Remove programs. 
4. Click Install. 
5. Click Next. (Windows searches the floppy disk and CD-ROM drives for an installation program. It 

should find setup.exe. If setup.exe is not found, click Browse and select setup.exe on the 
installation disk.) 

6. Click Finish to begin the actual installation. 
 
The installation program prompts you for the information it needs, such as the hard drive and folder in 
which to install Orchestrate. If multiple floppies are required, you will be prompted to insert the additional 
disks as they are needed. 

Uninstalling Orchestrate 
Removal is easy— Windows does it for you. 
1. Select Start/Settings/Control Panel 
2. Double-click Add/Remove programs.  
3. Highlight “Orchestrate” in the list box. 
4. Click Add/Remove. 
5. In the Confirm File Deletion dialog box, click Yes to remove Orchestrate. 
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Orchestrate User Interface 
Orchestrate is a Multiple Document Interface (MDI) application. This means that more than one script can 
be open at a time. You can move between various scripts by pressing Ctrl+Tab or clicking the Window 
command and then selecting the script you wish to make active.  
 
The screen below shows a typical Orchestrate script with various Commands and Arguments. Each 
command occupies a single line in the spreadsheet. All commands (other than the telescope slewing 
commands) are slightly indented to differentiate from commands that move the telescope. One can quickly 
see which operations occur at each telescope position.  

Spreadsheet Columns  

 
The spreadsheet that displays the Orchestrate script serves several purposes. In addition displaying each 
command contained in the script, it provides a sort of “control center” for running the script and stepping 
through various parts of the script. As each command is executed, information about result of the command 
is displayed in the “Status” column.  
 
Further to the right on the spreadsheet and usually out of view are three additional columns of data, 
Compiled Cmd, Compiled Arg1 and Compiled Arg2. These show the script in its raw form as used 
internally by Orchestrate. Syntax errors within scripts can usually be detected quickly by comparing these 
fields to the actual script. 

The Orchestrate Scripting Language 
The Orchestrate scripting language consists of the following commands. Commands are like verbs, that is, 
they result in some sort of action when executed. For example, the command SlewToRaDec instructs the 
telescope to move to a specific equatorial coordinate. The equatorial coordinates are the arguments 
associated with the command. Most commands require at least one argument.  
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Arguments are compiled into either numbers or other instructions that are usable by Orchestrate. For 
example, 1h 30m 0s is compiled into a decimal number “1.50000 hours” instead of one hour and 30 
minutes.  
 
Following is a list of the commands available in Orchestrate along with sample arguments and usage.  
 
 
Command 

Expected 
Argument(s) 

 
Sample 

 
Uses 

SlewToRaDec Right ascension and 
declination. 

12h 30m 0s +30d 45m 45s or 
12.50000h +30.75000d. See 
format notes below. 

TheSky telescope 
control.  

SlewToObject Celestial object name. M42, NGC5243, GSC 123:443 
etc. See the Find command in 
TheSky.  

TheSky database and 
telescope control.  

SlewToAzAlt Azimuth and altitude 
coordinates. 

178d14m10s 45d10m10s  TheSky site location 
and telescope control.  

SetTrackingRate On or Off. Off TheSky telescope 
control. 

Jog A string of characters 
representing the 
direction (North, 
South, East, West, Up, 
Down, Left or Right) 
to move the telescope 
and an amount to 
move in arc minutes. 

North 10 
South 12.2 
Up 7.23 

TheSky telescope 
control.  

TakeImage Exposure time in 
seconds. 

60s CCDSoft camera 
control.  

SetFilter A string representing 
the filter name or a 
number representing 
the filter number. 

Red  
-or- 
3 

CCDSoft filter wheel 
control. 

SetTemperature A temperature set 
point for the camera or 
the word Off. 

-25.0 
-5.0 
Off 

CCDSoft camera 
control. 

SetResolution A resolution of the 
camera. 

High 
Medium 
Low 

CCDSoft camera 
control. 

SetFrameMode Set the option that 
determines if a Dark 
and Light frame are 
taken or just a dark or 
just a light 

Dark and Light 
Light 
Dark 

CCDSoft camera 
control 

SetShutterStrobing Off or On. Turns 
shutter strobing on or 
off. 

Off 
On 

CCDSoft camera 
control 

WaitFor Delay in seconds. 30 Orchestrate delay 
timer. 

WaitUntil Time of day and date.  01/31/1997 01h02m03s (Exact 
format required) 

Orchestrate absolute 
timer. 

ImageThenSlewTo Exposure time in 
seconds and next 
object to slew to while 
the current exposure 
downloads. 

10 NGC 7754 TheSky telescope 
control and CCDSoft 
camera control. 
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AutoMap None.  TheSky’s Image Link 
capabilities, 
CCDSoft’s CCD 
images, and TPoint’s 
mapping functions.  

AppStart One of the following: 
THESKY, CCDSOFT, 
OBSERVATORY, 
SCHEDULER, 
VISITORSCENTER, 
TPOINT, GPSTFP, 
ORCHESTRATE or 
AUTOMADOME.  
See command notes 
below. 
 

AppStart THESKY The application as the 
argument. 

AppStartup See AppStart’s 
arguments. See 
command notes below. 

AppStartup THESKY  

AppShutdown See AppStart’s 
arguments. See 
command notes below. 

AppShutdown THESKY  

AppExit See AppStart’s 
arguments. See 
command notes below. 

AppExit THESKY  

RebootWindows None.   
 
 

ImageThenSlewTo Notes 
ImageThenSlewTo is a specialized command that minimizes the time required to repeatedly take CCD 
exposures then slew to objects.  This is accomplished by simultaneously downloading an image from the 
camera while slewing the telescope to the next object.  In order for this command to work correctly, you 
must make the following two settings: In TheSky, go to Telescope, Server Settings, and check the “Remote 
clients use Orchestrate’s ‘ImageThenSlewTo’ command” option.  In CCDSoft, go to Camera, Server 
Settings, and check “Remote clients use Orchestrate’s ‘ImageThenSlewTo’ command” option. Exit and 
restart CCDSoft for this option to take effect. 

SetShutterStrobing Notes 
Only certain types of CCD cameras have shutter strobing support. Please contact Software Bisque for a list 
of those cameras. 

AutoMap Notes 
The AutoMap command adds a map point to the TPoint model in TheSky based on a successful image link 
of the last exposure taken.  The normal sequence of commands in your script would be: 
 
SlewToObject (or SlewToRaDec or SlewToAzAlt) 
TakeExposure 
AutoMap 
 
You may use TheSky’s Exporting command to easily create a list of SlewToObject commands, and add the 
additional TakeExposure, AutoMap commands.  The resulting script allows you to map your telescope with 
your CCD camera and without any human intervention.  This is a closed loop method of mapping your 
telescope; that is, your telescope model’s mapping points are based on the astrometric center of the image 
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acquired.  The exposure time on the TakeExposure command must be long enough so that several stars are 
visible on the image so an image link is possible.  Typically, ten to twenty seconds is sufficient. 
 
In CCDSoft’s Camera, Server Settings, the “Remote clients use Orchestrate’s Auto-Map Capabilities” must 
be checked in order for AutoMap to work properly. 

TakeExposure Notes for Windows 95 Users 
CCDSoft must be the active window when running an Orchestrate script to ensure camera downloads are 
finished in a timely fashion.  To make CCDSoft the active window, simply click its caption after starting 
your Orchestrate script (make CCDSoft the topmost window). 
 

AppStart, AppStartup, AppShutdown, AppExit Command Notes 
The AppStart command allows you to start any of the Software Bisque applications.  The AppStartup 
command runs an embedded startup procedure in the respective application. The AppShutdown command 
runs an embedded shutdown procedure in the respective application. The AppExit command allows you to 
exit any of the Software Bisque applications. 
 
The following table describes what the AppStartup command does for each of the following applications.  
If an application is not listed, its AppStartup procedure does nothing. 
Application Argument Procedure 
THESKY No argument does the entire 

procedure.  A decimal argument 
can act as bit wise mask to skip 
any step in the procedure. 

1. Connects to the telescope (bit 0). 
2. Commutates telescope motors (bit 1). 
3. Connects to the dome (bit 2).  
4. Couples TheSky and the dome (bit 3). 

CCDSOFT  1. Connects to the camera. 
2. Sets the camera temperature. 
3. Wait for the camera to come to 

temperature. 
ORCHESTRATE No argument does the entire 

procedure.  A decimal argument 
can act as bit wise mask to skip 
any step in the procedure. 

1. Connects TheSky (bit 0). 
2. Connects the telescope (bit 1). 
3. Connect the camera (bit 2). 
4. Connects the filter wheel (bit 3). 

AUTOMADOME No argument does the entire 
procedure.  A decimal argument 
can act as bit wise mask to skip 
any step in the procedure. 

1. Connect the dome (bit 0). 
2. Does a “Find Home” command (bit 1). 
3. Opens the dome slit (bit 2). 

 
The following table describes what the AppShutdown command does for each of the following 
applications.  If an application is not listed, its AppShutdown procedure does nothing. 
Application Argument Procedure 
THESKY No argument does the entire procedure.  

A decimal argument can act as bit wise 
mask to skip any step in the procedure. 

1. Disconnects dome (bit 0). 
2. Parks telescope (bit 1). 
3. Disconnects telescope (bit 2). 

CCDSOFT  1. Shuts off camera temperature. 
2. Disconnects camera. 

ORCHESTRATE No argument does the entire procedure.  
A decimal argument can act as bit wise 
mask to skip any step in the procedure. 

1. Disconnects TheSky (bit 0). 
2. Disconnects the telescope (bit 1). 
3. Disconnect the camera (bit 2). 
4. Disconnects the filter wheel (bit 3). 

AUTOMADOME No argument does the entire procedure.  
A decimal argument can act as bit wise 
mask to skip any step in the procedure. 

1. Closes the dome slit (bit 0). 
2. Parks the dome (bit 1). 
3. Disconnects the dome (bit 2). 
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The above commands allow you to both startup and shutdown your system in a scripted manner.  This can 
even be done remotely, using Orchestrate’s watched folders.  Simply copy your customized startup or 
shutdown script to the watched folder.  Moreover, by put putting Orchestrate in you computer’s startup 
folder (so Orchestrate will run each time you computer starts), your system will be receptive to scripts even 
after a reboot. 
 
Here is a typical customized start up script that can be pasted into Orchestrate for those who do not have 
domes.  Note the argument for the AppStartup command for TheSky that will only connect the telescope 
and skip commutation and connection to the dome because bit 0 is only on.   
 
AppStart,TheSky, 
AppStart,CCDSoft, 
AppStartup,TheSky 1, 
AppStartup,CCDSoft, 
AppStartup,Orchestrate, 
 
Here is a typical customized shutdown script that can be pasted into Orchestrate.  Note the argument for the 
AppShutdown command for TheSky will only Park and disconnect the telescope.  The dome will not be 
involved because only bits 1 and 2 are on.     The argument of 1 on the AppExit command for TheSky and 
CCDSoft cause them to exit forcefully and ignore any external connections (recommended otherwise they 
may not exit with a message box indicating another process is using their services). 
 
AppShutDown,Orchestrate, 
AppShutDown,CCDSoft, 
AppShutDown,TheSky 6, 
AppExit,CCDSoft 1, 
AppExit,TheSky 1, 
 

Format Notes 
There are a number of different acceptable formats when entering equatorial or horizon coordinates as 
arguments to Orchestrate commands. Each number must be followed by a corresponding letter designating 
degrees, hours, minutes or seconds. Numbers can be entered in either decimal or hours, minutes, seconds 
(HMS)/degrees, minutes, seconds (DMS) formats.  Formatting is automatic if the TheSky’s Data Exporting 
is used. 
 

Sample Compiles to Example of 
Erroneous Input  

Problem 

12h 30m 0s 12.500000h 12h 30 00 The letters ‘m’ and ‘s’ 
are missing.  

12.50000h 12.50000h 12.5 The letter ‘h’ is missing. 
30d 45m 00s 30.75000d 30d45’0” The letters ‘m’ and ‘s’ 

must be used to 
designate minutes and 
seconds. 

 

The Comment Field 
This field can be used to add any additional textual information you desire.  It is not used by Orchestrate, 
but is saved as in the header of FITS image files generated by CCDSoft.  See the CCDSoft documentation 
for additional information. TheSky’s Export command automatically places the right ascension and 
declination of each object in the comment field. This can be a helpful reference when examining a script 
command, such as SlewToObject NGC2245, and the coordinates of the object are needed.  
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Typing in Scripts 
In most circumstances, TheSky’s Export command creates scripts or some other database application that 
generates properly formatted lists. However, when using Orchestrate interactively, you will usually be 
typing in each command and argument(s).  
 

A list of available commands can be shown on the screen by clicking View Command List. This shows the 
correct name for each command. When entering commands, the entire command does not have to be typed, 
only enough characters to distinguish the desired command from other commands. For example, entering 
“Take” then pressing the Tab key to move to the arguments field automatically fills in the “TakeImage” 
command.  

Importing Scripts 
Scripts that are generated by other applications (such as TheSky’s Export command) can be imported into 
Orchestrate using the Import command on the File menu, or directly from the clipboard using the Paste 
command from the Edit menu. The clipboard is the temporary storage and transfer area used frequently by 
Windows applications.  
 
The text file format is very similar to the format of the scripts within the Orchestrate application with the 
exception that commands, arguments and comments are separated by commas when in text files.  
 
For example, the following script is formatted properly for importing into Orchestrate. Note that there are 
two commas on each line, separating the Command from the argument and the argument from the 
comment.  
 
SlewToObject   ,  NGC7063                 ,   21.40667  36.50000           
SetFilter      ,  1                       ,                                
WaitFor        ,  10                      ,                                
TakeImage      ,  60                      ,                                
TakeImage      ,  60                      ,                                
SlewToObject   ,  CGCG512-4               ,   21.47489  35.30417           
SetFilter      ,  1                       ,                                
WaitFor        ,  10                      ,                                
TakeImage      ,  60                      ,                                
TakeImage      ,  60                      ,                                
 
Note that the spacing is not important between the various fields. Only the commas are used to separate the 
various parts of a command line.  
 
Using the Clipboard 
If a text-based script is present in the clipboard, you can copy it into an Orchestrate document. Use the File 
New command to create an empty Orchestrate document. Then, from the Edit menu, click the Paste 
command to copy the contents of the clipboard into the Orchestrate document. 
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Exporting Scripts 
If you manually enter in a script within Orchestrate or modify an existing script, you can export the script 
to a text file for manipulation in other applications.  See the section “Importing Scripts” above for 
information about the format of text scripts.  
 

Establishing Connections to Software Applications or Hardware Devices 
Selecting the desired application or device from the Connections menu performs connections to software 
applications or hardware devices (TheSky, telescope, CCD camera and filter wheel) that Orchestrate can 
control. Before attempting to control each of the individual applications or devices under the direction of 
Orchestrate, make sure that TheSky and CCDSoft function standalone and the devices selected within those 
applications are available.  
 
For example, if the TakeImage command is used in a script, the CCD camera must be connected to the 
computer, on which CCDSoft is running and be operational. Since many applications are running 
simultaneously and a number of devices can be connected to each application, not all error situations are 
clearly described when a command fails.  Therefore, you must be familiar with the individual applications 
and their operations before continuing with Orchestrate.   

Establishing Remote Connections to Software Applications or Hardware Devices 
You can also use Orchestrate to connect to a remote observatory (that is, Orchestrate can be run on a 
different computer than the TheSky, CCDSoft, etc.).  You must correctly configure the Client under View, 
Properties.  Enter the IP address or name of the server computer running the RASServer software and enter 
a valid User Name and Password to log you on the remote observatory. 

Starting an Orchestrate Session 
To function properly, Orchestrate and the Observatory application must communicate with TheSky and 
CCDSoft. The following procedure requires that both TheSky and CCDSoft are installed and functioning 
properly.  See the “Server Settings in Observatory Application” section below for information about 
offering connections to these applications. 
 
Below are the steps that you will normally go through when you want to use Orchestrate.  Please note that 
these are order dependent! 
1.  Start TheSky, connect to the telescope and perform the necessary initializations. 
2.  Start CCDSoft, connect to the camera and perform the necessary initializations. 
3.  Start the Observatory program, and from the File menu, click New.  A new document appears showing 

all connections being offered to Orchestrate (for example, TheSky, Telescope, CCDSoft, Camera, and 
Filter Wheel). 

4.  Start Orchestrate, and from the Connections menu, connect to TheSky, Telescope, Camera and Filter 
Wheel.  
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Server Settings in Observatory Application 
The Observatory application acts as a “client” that communicates with up to three different “server” 
applications: TheSky, CCDSoft and AutomaDome.  From the Observatory application, use the Server 
Connections command in the Observatory menu to specify the applications that Orchestrate will be 
communicate with.   
 
For example, suppose you want to run a test script in Orchestrate that just slews the telescope to different 
objects in the sky.  No connection with CCDSoft or AutomaDome would be required.  From the 
Observatory application, on the Observatory menu, click Server Connections (Note: The Observatory menu 
is only present if there are no Observatory documents loaded).  In the Server Connections dialog box, mark 
the TheSky checkbox and clear the CCDSoft and AutomaDome checkboxes.   

 
When a new Observatory document is created, only connections to TheSky will be established.  In the 
Observatory document, the following text appears: 
 
Offering Connections To: 
 TheSky  
 Telescope 
 

Running Scripts 
Once you have established connections to the various applications and devices that will be used in the 
script, you are ready to execute the script.  
 
Running a Script 
On the Script menu, use the Run command to start a script. The script starts at the first line in the script 
unless a particular line is highlighted elsewhere in the script.  
 
Starting Past the Beginning 
Scripts can be started and run from any line.  For example, in the script shown below a Run or Step 
command causes the SlewToObject instruction to be executed (line number six in the script) rather than 
starting at the beginning.  
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To highlight a line or multiple lines in a script, click on the numbers to the left of the commands in the 
spreadsheet. Drag over desired numbers to highlight multiple lines.  
 
Executing a Portion of a Script 
To execute a series of sequential commands within a script, highlight the commands in the script then click 
the Run command from the Script menu. Only the highlighted commands are executed. In the example 
below, only commands six through 10 will be executed when the Run command is issued.  
 
Running a Script Continuously 
Setting the Loop command under the Script menu causes the current script to be executed continuously. As 
soon as the end of the script is reached, it will restart at the beginning.  
 
Running a Portion of a Script Continuously 
To execute a series of commands within a script repeatedly, click Macro Loop. Next highlight the 
commands in the script then click Script Run. Only the highlighted commands will be executed, and once 
the last highlighted command is executed, it will jump to the first highlighted command and continue 
execution.   
 
Stopping a Script 
This command can be used to stop the execution of script without aborting the command that is currently in 
progress. Only after the command is completed and control is returned to Orchestrate will the script be 
stopped.  For example, if you are in the middle of a 120-second exposure and you press the Stop button, the 
exposure will be completed but the next command in the script will not be executed. This is in contrast with 
the Abort command described below.   

Aborting a Script 
The Abort command immediately stops script execution and aborts any command currently in progress.  
For example, clicking abort while the telescope is slewing will immediately cause the Telescope to stop 
slewing.  If an exposure is in progress, the exposure is aborted.  
 
Sample Scripts 
 
 Comments  
SlewToObject NGC4114 12.12008 -14.18528 
WaitFor 10  
TakeImage 60  



Orchestrate 17 
 

TakeImage 60  
SlewToObject KARA-DWARF 12.24128 -12.32778 
WaitFor 10  
TakeImage 60  
TakeImage 60  
SlewToObject NGC4263 12.32839 -12.22500 
WaitFor 10  
TakeImage 60  
TakeImage 60  
SlewToObject NGC4329 12.38911 -12.55861 
WaitFor 10  
TakeImage 60  
TakeImage 60  
 

Ending an Orchestrate Session 
These are order dependent! 
1.  Exit Orchestrate. 
2.  Exit the Observatory program. 
3.  Exit TheSky and or CCDSoft. 
 
If you have Orchestrate running and have a connection to the TheSky (or CCDSoft) and exit TheSky (or 
CCDSoft), you will be warned that other applications are connected to TheSky (or CCDSoft).  You need to 
exit Orchestrate before exiting TheSky (or CCDSoft). 
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Exporting Data from TheSky  
The Export command uses the extensive database functions of TheSky Astronomy Software setup queries 
and export lists of information. The capabilities go beyond simply extracting celestial data from TheSky.  
 
The Export command is also closely tied with Orchestrate. This command provides quickest and easiest 
means of generating Orchestrate Scripts.  
 
The number of different queries possible is nearly endless.  Following are just a few examples of the types 
queries that can be used to generate lists. 
 
? ? NGC open-clusters currently above the horizon.  
? ? Galaxies in TheSky database brighter than 12 magnitude with a size of four arc-minutes or greater. 
? ? Minor planets currently between 4 hours RA and 6 hours RA above 30 degrees altitude. 
? ? Man-made satellites currently above the horizon. 
? ? Stars currently visible on the Sky Display. 
 
Once the lists are generated, they can be sorted in a number of different ways. You can even choose to have 
them optimized so that the path between the various objects, from a telescope slewing perspective, is 
minimized.  
 
The Export command uses a number of different tabbed dialogs, or tabs, for specifying the desired type of 
list.  The options in each tab are described below. 

General  
The General tab is used to create the list of exported data 
and is based on the options in all other tabs. Once the 
search criteria, or query, is entered, clicking the Create List 
button causes databases to be scanned and objects that 
satisfy the query are added to the list. Information in the 
Source/Destination, Filter and Sort tabs is always used to 
generate lists.  

Simple List Format  
A Simple List adds a single line to the textual list for each 
object that is added. The general format of each line 
includes the Name, Object Type, Equatorial Coordinates, 
Magnitude, Major and Minor axis of the object.  
 
For example, the following is a sample list created of 
galaxies surrounding NGC 891: 

 
 
CGCG538-47       Galaxy            02h 21m 05.50s     +41°49'12.0"   15.6   0.0   0.0  
CGCG538-54       Galaxy            02h 22m 50.40s     +42°09'29.0"   15.8   0.0   0.0  
NGC891           Spiral Galaxy     02h 22m 33.00s     +42°20'48.0"   10.8  13.4   2.5  
CGCG539-5        Galaxy            02h 23m 53.60s     +42°12'22.0"   15.8   0.0   0.0  
CGCG539-9        Galaxy            02h 24m 47.20s     +42°01'28.0"   15.8   0.0   0.0  
NGC906           Spiral Galaxy     02h 25m 16.30s     +42°05'23.0"   14.0   1.8   1.6  
NGC911           Elliptical Galax  02h 25m 42.40s     +41°57'22.0"   13.7   1.7   0.9  
NGC914           Spiral Galaxy     02h 26m 05.10s     +42°08'38.0"   13.7   1.8   1.3  
CGCG539-26       Galaxy            02h 26m 55.00s     +42°01'00.0"   15.8   0.0   0.0  
UGC1859          Type C Galaxy     02h 24m 44.40s     +42°37'23.0"   13.9   1.7   1.1  
PGC9068          Galaxy            02h 23m 11.70s     +42°57'54.0"   30.0   0.0   0.0  
NGC898           Spiral Galaxy     02h 23m 20.30s     +41°57'04.0"   13.8   2.0   0.4  
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Orchestrate List Format 
Here is the same list as above, but this time the Orchestrate Script format was selected: 
 
SlewToObject, CGCG538-47,   2.35153  41.82000 
TakeImage      , 60                  ,  
SlewToObject, CGCG538-54,   2.38067  42.15806 
TakeImage      , 60                  ,  
SlewToObject, NGC891,   2.37583  42.34667  
TakeImage      , 60                  ,  
SlewToObject, CGCG539-5,   2.39822  42.20611 
TakeImage      , 60                  ,  
SlewToObject, CGCG539-9,   2.41311  42.02444 
TakeImage      , 60                  ,  
SlewToObject, NGC906,   2.42119  42.08972  
TakeImage      , 60                  ,  
SlewToObject, NGC911,   2.42844  41.95611  
TakeImage      , 60                  ,  
SlewToObject, NGC914,   2.43475  42.14389  
TakeImage      , 60                  ,  
SlewToObject, CGCG539-26,   2.44861  42.01667 
TakeImage      , 60                  ,  
SlewToObject, UGC1859,   2.41233  42.62305  
TakeImage      , 60                  ,  
SlewToObject, PGC9068,   2.38658  42.96500  
TakeImage      , 60                  ,  
SlewToObject, NGC898,   2.38897  41.95111  
TakeImage      , 60                  ,  
 

Show Path 
Click Show Path if you want to see lines connecting each of the objects in the created list. In the following 

Show Path example, you can see a series of lines connecting each of the galaxies on the Sky Display. 
Displaying paths is a good way to quickly verify that the generated list is what you expected.  

Number Format 
The equatorial or horizon coordinates generated by the Export command can be formatted in hours/degrees, 
minutes and seconds (HMS/DMS) or in decimal form.  
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HMS/DMS Sample 
CGCG538-47       Galaxy            02h 21m 05.50s     +41°49'12.0"   15.6   0.0   0.0  
CGCG538-54       Galaxy            02h 22m 50.40s     +42°09'29.0"   15.8   0.0   0.0  
 
Decimal Sample 
CGCG538-47       Galaxy                  2.3515278       41.8199984  15.6   0.0   0.0  
CGCG538-54       Galaxy                  2.3806668       42.1580552  15.8   0.0   0.0  

Object Type 
The Object Type specifies which of a number of distinctly different types will be included in the list.  

Deep Sky 
Deep Sky objects include non-stellar objects outside the solar system. Double and variable star are 
cataloged separately from stellar databases, so they too are considered deep sky objects.  
 
The section on Filtering below describes how you can further filter the Deep Sky category into only object 
types of interest.  

Minor Planets 
This option will traverse the list of extended minor planets that are currently computed. Extended minor 
planets differ from local minor planets in the following ways.  Local minor planets are included in time 
skip simulations and are updated each time the site information is changed.  Their number is limited to 100. 
The positions of over 40,000 extended minor planets can be computed and displayed on the Virtual Sky.  
This is very computationally intensive, so the positions of extended minor planets are computed only once.  
They remain visible for a specified period afterwards (up to three hours).  

Stars 
These lists contain stars from the TheSky’s stellar databases. The data source will be either the GSC (Guide 
Star Catalog) or the Hipparcos/Tycho catalogs. Since the most common use of stellar lists will be for 
astrometric purposes, the more accurate Hipparcos/Tycho positional information will be used when 
available.  

Satellites 
Lists of man-made satellites can be generated from those currently loaded in TheSky. Satellites are loaded 
using the Satellites Dialog in the Data menu.  
 
The position of fast moving satellites changes so rapidly that filtering based on coordinates may not make 
sense. Slower satellites such as geosynchronous and GPS satellites can be filtered based on their horizon 
coordinates. When an Orchestrate script containing satellites is generated, two SlewTo entries are generated 
for each object. This allows the telescope to refine its position, as the satellite no doubt moved while the 
telescope was slewing.  

Map Points 
These lists are used specifically for generating evenly distributed points across the sky that will be used for 
mapping a telescope.  
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List Source/Destination 
  
There are many options for specifying the source of the list’s data. You may want those objects currently 
visible on the Sky Display, or you may wish to individually select each object to be added to the list.  

 
Once created, the list is output to either the Windows 
clipboard or an ASCII text file. The data can then be used 
by other applications such as Orchestrate. 

Data Source 

On Sky Display 
The most effective method for selecting objects in a certain 
part of the sky is using all of the built in features of 
TheSky. 
 
Using the Zoom, Up, Down, Left, and Right commands, 
the Sky Display can be adjusted as needed to determine the 
spatial extents of the objects that will be included in the 
query.  

 
Using the various built in filters contained within TheSky, you be very selective as to the types and 
magnitudes of objects that are displayed. This filtering carries into the Export command when the On Sky 
Display option is selected.  
 
The Sky Display Filters can also be used when generating lists using the Selected Catalogs option. This is 
discussed in the Export command’s Filter section below. 

Selected catalogs 
Use this option when lists of entire object classes from various deep-sky catalogs are required.  Data from 
one or more of the NGC, IC, PGC or Messier catalogs can be included. 
Note that the PGC catalog contains over 70,000 entries, so traversing this 
list of objects can require be time consuming.  
 
This option can also be used when generating lists of minor planets or 
satellites. Rather than selecting from minor planets or satellites on the Sky 
Display, the entire database that is currently loaded is traversed. When 
making lists of minor planets, the entire set of extended minor planets is 
searched. When making lists of satellites, each satellite contained in the 
current Two-Line-Element file (TLE) is searched.  
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Add User Data Content 
If you wish to individually select each object for a list, you can use the Add User Data command of 
TheSky. Objects are added to the User Data area in TheSky using Ctrl+Click on each object. These objects 
can then be copied into the Export command by choosing this option. 

 
Example: 
The following steps are used to “queue” a dozen galaxies of the more than 40 that are currently on the Sky 
Display.  
1. Click Data Add User Data. 
2. Click Remove All to clear the user data area. 
3. Select Nearest non-stellar in the Snap To list box. 
4. Close Add User Data dialog. 
5. Hold down the Ctrl key, and click on each non-stellar object you wish to add to the list. When finished, 

Click Data, Export command. 
 
Once each of the individual objects is in the user data area, they can be added to a list by using the User 
Data Content list source. 

Mosaic content 
When an area of the sky needs to be covered systematically, the mosaic feature in TheSky can be used to 
generate a series of equatorial coordinate centers based on a specified Field of View Indicator.  For 
example, if your optical system yields a field of view of 15x15 arc-minutes, a series of four images is 
required to cover the entire moon (which is approximately 30x30 arc-minutes across).  
 
Once generated in TheSky, these points can be transferred into the Export command with this option. 

Data Destination 
When a list of objects is created, it can be directed to a text file or the Windows clipboard.  

ASCII Text File 
Choosing this option causes the list to be sent to a text file. You can choose the name of the text file by 
clicking the Browse button. A default file name “REPORT.TXT” is used if a different file name is not 
specified. Each time Create List is selected from the General Tab of the Export dialog, the text file will be 
overwritten.  
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Clipboard 
If you wish to copy the created list to another application such as Orchestrate, the quickest method is using 
the Windows Clipboard. The list content is copied as ASCII text so it can be pasted into other applications 
such as word processors, text editors, etc. 

Filtering Objects 
The Filter tab provides additional query properties for exporting data.  These additional filters can help you 
select objects from a particular region of the sky or objects that have certain properties.  

 
Filters can be used together and the number of combinations of different filters can quickly become 
daunting.  Most of the time only one or two filter parameters are used.  The default filter values perform no 
filtering; that is, they include all ranges of the sky, all object sizes and all magnitudes. 

Equatorial 
Use these filters to specify a particular region of the sky in the query.  For example, if you want to include 
only objects between declination 60 and 80 degrees, set the minimum declination to 60 degrees and the 
maximum declination to 80 degrees.  

Horizon-based 
The horizon-based coordinate filters are relative to the current date, time and location entered in the Site 
Information dialog.  If you are planning an observing session during the day using filters based on altitude 
and azimuth, make sure to set the time information correctly for when you will be observing. 

Size 
Enter the minimum and maximum size of deep-sky objects that should be included in the exported data. 
The size is entered in arc-minutes. This option only applies when Deep Sky option is selected from the 
General tab; otherwise, it is ignored. 

Magnitude 
Enter the limiting magnitude for the query. 

Sky Display Filters 
Click this button to display the Filters dialog box so that different object types can be turned on or off.  This 
allows even greater filtering capabilities.  For example, you could query only for open clusters by turning 
off all other deep-sky object types. 
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Default 
This button sets all filter values to their minimum or maximum values thereby making them inactive.  For 
example, the minimum right ascension value is set to 0.0 and the maximum to 24.0. Since this range of 
right ascension must include all objects, this filter is effectively inactive. 

Sorting 
Object data that is exported during a query can be sorted using several different techniques.  If the RA 
option Sort Type option is selected, then the objects are sorted based on their right ascension.  If the 
Declination Sort Type option is selected, then the objects in the list are sorted by declination. The sort order 
can be ascending (increasing values) or descending (decreasing values).  
 

Path 
To increase the efficiency of a robotic telescope mount, the slew time between objects can be minimized. 
This is accomplished by selecting the Shortest Path option in the Sort tab.  
 
The first option, Shortest, Object to Object begins at the first object in the list (the first object also depends 
on the Sort Type) and finds the next closest object until all objects in the list are exhausted.  “Closeness” is 
defined as the minimum right ascension or declination angle, not angular separation.  For example, at high 
declinations, moving an angular distance of one degree might require a 60-degree actual slew in right 
ascension.  
 
The second option Shortest, From Starting Point keeps a list close to the original sorted order. 
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Above are sample star charts created by TheSky using the Export command.  In Figure 1, a script was 
created to slew to each of the non-stellar objects on the Virtual Sky, with no sorting.  In Figure 2, the 
objects are sorted in RA.  In Figure 3, the shortest path, object to object optimization is enable. There are 
significantly fewer “connect-the-dot” lines on this chart relative to the others; therefore, telescope slewing 
is minimized. 

Scripting 
The ability to generate scripts for the Orchestrate scripting program is perhaps the most powerful feature of 
the Export command. Using options in the Scripting tab, you specify which operations will be performed at 
each stop of the telescope during a script.  
 
Control of the telescope, CCD camera and filter wheel is done in Orchestrate by using various commands 
and their associated arguments.   
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Figure 1 - No sorting. Figure 2-Sorted by right ascension. 

Figure 3 - Sorted by right ascension and 
shortest path, object to object. 
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Slew Command 
Note that the Slew command is the first prompt on the Scripting dialog. This Orchestrate command can be 
one of the following: SlewToObject, SlewToRADec or SlewToAzAlt. When scripting deep-sky objects, 
generally the SlewToObject command should be used since it makes the script very readable. For example, 
understanding “SlewToObject  M42” is much easier than “SlewToRADec 5h35m24s –5d25’30" .”  
 
The SlewToRADec command causes the Export command to insert the equatorial coordinates of each 
object in the SlewTo command rather than the object name. In some circumstances, this might be preferred 
since when the script is executed, the databases of TheSky do not have to be queried to determine the 
coordinates of the object before issuing the SlewTo command to the telescope.  
 
If you are creating a script that directs the telescope to moving objects such as minor planets or satellites, 
then use the SlewToObject command.  Otherwise, the coordinates generated at the time the script is created 
will be incorrect for the time the script is actually run. When the SlewToObject command is used on minor 
planets or satellites, the position of the object in question is computed at that time. When satellites are 
included in a script, two (2) slew commands are automatically generated because during the first slew the 
satellite may move a significant distance. In practice, the second slew generally is short enough to get to the 
satellite before it has moved significantly.  

Operations after Each Slew 
Once the telescope is pointed to the desired coordinates by using the appropriate Slew command, you will 
may want to take an image with a CCD camera or perhaps pause long enough to observe through an 
eyepiece.  Other possible operations include setting a filter on the filter wheel, or taking multiple CCD 
images of varying lengths.  All of this is possible using the Orchestrate command language.  
 
The procedure for creating a set of operations to perform at each Slew location is as follows.  
 
? ? Select the desired command from the command list.  
? ? Enter the argument associated with the command if applicable.  
? ? Choose Add operation.  
 
For example, to take a 60 second image you would select the TakeImage command then enter 60 in the edit 
control to the right of the command list. Then choose Add operation. You will see the following in the 
operations box: 
 
TakeImage,    60,    
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The commas that separate commands from arguments are automatically supplied. The last comma is added 
because there are 3 parts to each Orchestrate command,  
 
1. The command.  
2. The argument.  
3. A comment field.  
 
The comment field is very useful to annotate the operation.  Comment fields associated with the TakeImage 
command can be automatically added to FITS files as they are created.  
 
If you wish to take two 60-second exposures at each slew location then simply press the Add operation 
button again to add a second TakeImage command to the list.  
 
Here are a few samples of operation lists: 
 
WaitFor        , 15                  ,  
TakeImage      , 60                  ,  
TakeImage      , 60                  ,  
Jog            , north 10            ,  
TakeImage      , 60                  ,  
TakeImage      , 60                  ,  
 
In the above sample, after the slew we wait for 15 seconds, to reduce any motion from the telescope mount 
from the slew and possibly eliminate any backlash in the system. We then take a 60-second exposure 
followed by another 60-second exposure. Then, the telescope jogs North 10 arc-minutes and we take two 
more 60-second exposures.  

Mapping 
The Mapping tab contains options for generating a list of evenly distributed points for a region of the sky 
that can be used for mapping an automated telescope.   

 
The graphic on the Mapping tab represents a horizon-based overhead view, looking down the zenith.  The 
red shaded area represents the area of the sky over which an evenly distributed set of points will be 
generated.   
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Use this graphic to define the region of the sky over which a telescope-mapping run will take place.  Click 
and drag the two small triangles to define the starting and ending azimuths of the region.  Click and drag 
the two small white circles to define the starting and ending altitudes of the region.   
 
The density of points in the region is adjusted using the slider control below the graphic.  Drag the slider to 
the left to increase the density of evenly distributed points over the region.   
 
Once these five parameters are defined, from the General tab, click the Query button to generate the list of 
points. 
 

Watched Folder 
 
You can configure Orchestrate to “watch” or monitor a folder for new scripts.  When a script appears in the 
Watch Folder (typically put there by some external process like an FTP copy, batch-file copy, etc.), 
Orchestrate will automatically import and run the script.   Once the script is run, it is placed in the Done 
Folder.  You can set the Watched Folder and Done Folder from the Options, Watched Folder, Setup 
command.  
 
Scripts must be in text format, not in the native Orchestrate file format.  Using the text format allows other 
applications to easily generate Orchestrate scripts without needing to know Orchestrate’s native file format.   
 
Hint:  To generate the text script file format, highlight one or more lines in a loaded script.  Then, from the 
Edit menu, click Copy.  Next, from any text editor like Windows Notepad, on the Edit menu, click Paste.  
Orchestrate can be used to both create (Edit, Copy or File, Export) and import (File, Import) the text script 
file format. 

Watched Folder Conventions 

Script Number  
A text script file copied into the Watched Folder must have eight digits, with a “.txt” extension; for 
example, 00000001.txt.  The eight digits represent the script number.  Scripts are run in order of script 
number, not by the date of the file.  That is, script 00000001.TXT is always run before script 
00000002.TXT.  Successive script numbers do not have to increase by one.   

Handshake File 
Before Orchestrate will load a file from the Watched Folder, a file named “HANDSHAKE” (without any 
extension) must be present in the Watched Folder and have a date later than or the same as that of the text 
script file with the lowest script number.  The handshake file prevents Orchestrate from reading the file 
while another process is writing the file. 

Corresponding TLE File 
Orchestrate will also load a corresponding TLE file into TheSky if such a file exits in the Watched Folder.  
An example of a corresponding TLE for 00000001.TXT would be 00000001.TLE.  Orchestrate will load 
the corresponding TLE into TheSky before the script is run.  This way, very current TLE elements can be 
maintained.  A corresponding TLE file is not required.  If there is no corresponding TLE, the text script 
will run as normal. 

Working Folder 
Before Orchestrate runs a text script from the Watched Folder, the text script file and the corresponding 
TLE file (if it exists) are moved to the working folder.  The working folder is a folder named “Working” in 
the Orchestrate folder (the folder where Orchestrate is run).  This convention makes it apparent which 
script is currently being run by simply looking at the contents of the Working folder.   
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Done Folder 
Once a script is complete, it is saved into the Done Folder as a native Orchestrate file with a name that 
corresponds to the text script file name.  To keep with our example, 00000001.TXT produces a 
corresponding 00000001.ORC file in the Done Folder.  In addition, the text script file and the 
corresponding TLE file are also moved to the Done Folder.   
 
The native Orchestrate file holds valuable debugging information like how well the import took place (do 
the text script file and Orchestrate files match?) and the error log.  If an error occurs anywhere along the 
watch folder process, any pertinent files end up in a folder named Errors in the Done Folder.  Look at the 
error log in the corresponding Orchestrate file to determine where the error occurred.  An error encountered 
does not cause watch process to stop.  So if 00000001.txt ended up with an error, 00000002.txt, 
00000003.txt, and so on, would still be run. 

Turning on the Watch 
To start monitoring the Watched Folder, go to Option, Watched Folder, Start Watch. 
 
 


